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1. Introduction

This tutorial introduces you to ArcGIS 10.3.1 and shows you how to create a simple map using urban and state data
sources. ArcCatalog and ArcMap are two modules in ArcGIS Desktop. You use ArcCatalog to manage your data and
ArcMap to create maps, query data, perform analysis, and most of the other basic GIS operations. ArcMap is the module
that you will use most frequently. The tutorial may take 3-4 hours to complete.

Download the tutorial data

Download the GIS tutorial data.zip file that accompanies this tutorial. The data can also be found in the S
drive/Tutorials/Tufts/Tutorial Data/ArcGIS_Basics_Somerville. Copy and paste this zipped file to your H Drive.

If you’re working in the Data Lab, unzip this file to your H: drive into a new folder called ArcGIS Basics. To do so, right
click on the folder and click Extract To =>ArcGIS Basics. At home or in another Tufts lab, unzip it in a location of your
choice. This results in two subfolders containing data from MassGIS (the Massachusetts GIS Repository) and the City of
Somerville, MA.


http://sites.tufts.edu/gis/files/2013/11/GIS_Tutorial_Data.zip
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2. Previewing and Managing Data with ArcCatalog

ArcCatalog is one of the modules in ArcGIS. You use it to manage your data sets (copying, pasting, deleting, and reading
metadata if available).

Starting ArcCatalog

Start ArcCatalog by going to Start = All Programs > GIS Applications = ArcGIS 10 = ArcCatalog 10.3.1 (note: This
might be in a different location in Boston or on the Grafton Campuses. Additionally, on your home computers with the
ArcGIS student license installed, the ArcGIS program may be under Programs =-ArcGIS 10.3.1).

The catalog tree on the left of the ArcCatalog window looks similar to a standard Windows file manager view, but the
ArcCatalog tree only shows data that can be read by ArcGIS.

Understanding and Using Folder Connections

On the left side of the screen, you will see the Catalog Tree. This shows all of the locations where you can access GIS
data. If you are in the Tufts Data Lab, you will see that you have three folder connections already —to H:, S:, and M:.

e The H: drive is your personal storage space.
e The M: drive holds data sets that Tufts has acquired for your use.
e The S: drive holds class specific materials.

The folder connection is a direct connection to these spaces in ArcGIS, and allows you to quickly access your data
without navigating repeatedly through long folder paths.

Working from Home or in another Tufts Computer Lab
If you are working in the Data Lab, skip this section! Go to next section — Navigating in ArcCatalog (Middle of p. 4).

At home or other locations outside the Tufts Data Lab, you will not have pre-set folder connections. You will need to add
these yourself. The first step is to think about how best to organize your work, and create the folders necessary in your
home computer using your Windows software. We suggest making a folder for your GIS class, and then subfolders for
your various assignments.

On your home computer, navigate to My Documents and make a folder called Intro_GIS_Class. Inside, make another
folder called ArcGIS Basics. Open the GIS_Tutorial_Data folder you unzipped, copy the Somerville and MassGIS
subfolders, and paste them into this new ArcGIS Basics folder.

Now, you need to connect to this data in ArcCatalog. This is how | would create a Folder Connection to that folder in
ArcCatalog:
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Select only the folder! Don’t drill down to the data itself! That way you have a connection to the folder holding all of

your data.

Look back to your Folder Connections in the Catalog Tree on the left side of the screen. Expand the Folder Connections
folder if it is not already (by double clicking) and you will see your new connection, as shown below:
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Navigating in ArcCatalog

1. In ArcCatalog, navigate to the location of the GIS data (in the Tisch Data Lab, this should be your H:/ArcGIS
Basics folder)

2. On the left side of the window, click to open the MassGIS/Physical_Resources folder (click on the plus signs to
expand the list and see the data within this folder)

3. Click on the landuse_poly clip file. This is a data set from the state of Massachusetts showing land use polygons
(e.g., residential, commercial, agriculture).

The landuse_poly clip file is called shape file. This is a very common GIS data format, created by ESRI, the makers of
ArcGIS. This is very important: a shape file actually consists of several files. Try looking at this file using Windows file
manager within the regular windows folder. You will see several files making up that one Shape file as shown below:

Windows File Manager View of ArcCatalog Tree view of
landuse_poly_clip shape file landuse_poly_clip shape file
|| landuse_poly_clip.dbf =1 £ Physical_Resources

(= hydro2Sk_arc_clip
E hydro25k_poly_clip
(&) landuse_poly_clip
I__'J landuse_poly_clip.sbx =] nwi_paly_clip

|| landuse_poly_clip.shp

| 7| landuse_pely_clip.prj

|| landuse_pely_clip.sbn

|Z| landuse_poly_clip.shp.xml

|| landuse_paly_clip.shx

All these files are necessary for this land use data set to be readable in a GIS software program. That's one reason why
ArcCatalog is a better program than Windows File Manager for managing GIS data. If you copy landuse_poly clip in
ArcCatalog to another folder, the ArcCatalog program knows to copy all the associated data files with it.

Copying and deleting GIS data sets in ArcCatalog

You can do the following ONLY if you are in the Tufts Data Lab! If you're working at home, skip this section and
continue to the next section (Previewing geography and attribute tables)

1. Inthe Catalog Tree, look in the Somerville folder — you’ll see a data set called Parcels2004. That’s a bit dated for
current mapping! We have a 2009 Parcels data set on our GIS data server that you can use for this tutorial if you
have access to the Tufts GIS Data Server (M: drive).

2. Inthe Catalog Tree, navigate to M:\City\Somerville\MIS
3. Right-click on SomervilleParcels09.shp and choose Copy
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4. In ArcCatalog, navigate back to your H: drive and the Somerville folder.

5. Right-click on the Somerville folder and choose Paste.
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6. You should now see SomervilleParcels09.shp in the folder. If you successfully copied the 2009 parcels to your
tutorial data set, then in the Catalog Tree, delete the Parcels2004 data set on your H: drive — either highlight it
and press the delete key or right-click on it and choose Delete (delete it only if you were able to copy the 2009
data set to your H: drive, otherwise do NOT delete Parcels2004! You can use the 2004 or 2009 data set for the
rest of this tutorial).

ArcCatalog has helped you capture all of the associated files, and delete or copy them as necessary — you just had to
click on one file. If you used Windows Explorer, you would have had to make sure you selected all of the associated files,
shown below. That’s why it’s so important to use ArcCatalog for copying, deleting and renaming files:
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|| Parcels2004.shx

Previewing geography and attribute tables

1. Click on landuse_poly_clip (located in MassGIS\Physical_Resources) in the catalog tree. Click on the Preview tab
above the right screen pane in order to view the shapefile.
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2. You should now see what landuse_poly clip actually looks like.

3. Click on the Identify tool at the top tool bar ( @ ) and then click on one of the landuse features in the
shapefile. You will see the information stored in the attribute table about that polygon. It doesn’t make much
sense yet!

4. Use the zoom and pan tools ( @ Q O ) to zoom in and out and pan around in the preview map. With the
zoom in tool (magnifying glass with a plus sign), you should use the mouse to draw a box around the area you
want to zoom in to (click on one corner, keep the mouse button held down, and drag it to the opposite corner of
the box before releasing). With the zoom-out tool, you also create a box - the current view will then be "zoomed

6
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out" to fit inside the box you created. To use the pan tool, select the hand-shaped tool, then hold down the
mouse button while you pan any direction to move the map. If your mouse has a scroll wheel, you can use that
to zoom in and out.

Q

5. To get back to the first (default) view, click on the world icon ( ) - this takes you to the full extent of that

particular data layer.

6. You can preview the attribute table (table of associated tabular information for a GIS data layer) by going down
the Preview form and choosing Table. This shows all the records in the GIS layer. Scroll down and across to see
the entire table.
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Reading data documentation (metadata)

When you were previewing the land use data set, it was difficult to understand what it was supposed to be representing.
And it was impossible to understand the coding scheme without further information. It is critical to have documentation
about the data you are using, and to document data that you create. Data documentation is called metadata.

1. MassGlIS, the statewide GIS clearinghouse, has excellent metadata online. Click here to read about the land use
data set: http://www.mass.gov/anf/research-and-tech/it-serv-and-support/application-serv/office-of-
geographic-information-massgis/datalayers/lus.html

2. Look through the land use data documentation. You can use this metadata to understand:

a) Isthe land use data set up to date (i.e., do you know from this data set what an area’s land use is
today)?

b) For what years is land use documented?


http://www.mass.gov/anf/research-and-tech/it-serv-and-support/application-serv/office-of-geographic-information-massgis/datalayers/lus.html
http://www.mass.gov/anf/research-and-tech/it-serv-and-support/application-serv/office-of-geographic-information-massgis/datalayers/lus.html
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c¢) What was the source of information for determining land uses?

3. Scroll down the MassGIS land use metadata web page until you find information about the attributes and the
codes that represent land uses.

4. Back in ArcCatalog Preview tab, preview Geography (so you see the map) and use the ldentify icon to click

on it. What was that area’s land use in 1971? Had it changed by 19997?

5. Metadata is also sometimes accessible within ArcCatalog, but only if the agency that created the data has
written metadata in a format that ArcCatalog can read. With landuse_clip_poly still highlighted in the Catalog
Tree, click on the Description tab above the map frame (located to the right of the Preview tab. Click No if you
are asked whether to upgrade metadata. You will see a shortened version of the MassGIS metadata page here.

6. Try using ArcCatalog to read the description of other data sets in your MassGlIS folder. Are all the data sets
documented in ArcCatalog?

7. Do the same for some of the data sets in the Somerville folder. What do you find when you look at metadata for
the Somerville data sets?

All US Federal agencies are required to document their GIS data following a geospatial metadata standard set out by the
US government. Most state agencies will also document their GIS data, but not necessarily to the Federal standard.
Local agencies vary widely in their documentation. Some do not document their data well or at all. Metadata is critical
to data users - without it, you may not know what a particular data layer represents, when it was created, if it is
complete, what the attributes mean, or what format it is in. We will discuss the importance of metadata more in class.

Get to know your data

Use what you have learned to look at other data sets in the GIS tutorial data set, including data for the City of
Somerville. Preview the maps and tables, and look at the metadata. Note that you can see the full list of MassGIS data
layers here: http://www.mass.gov/anf/research-and-tech/it-serv-and-support/application-serv/office-of-geographic-
information-massgis/datalayers/layerlist.html. There is no equivalent online clearinghouse for the Somerville data.

Summary

ArcCatalog is a useful way to manage your GIS data, for organizational functions like moving, copying, and renaming. It
also offers access to metadata if the source agency has put the documentation into a format that ArcGIS can read. In
many instances, you’ll find metadata online, or in a text file accompanying your data set. Sometimes, metadata may not
exist at all. It’s up to you to search for it and make sure you understand the data you are using.

You can also open ArcCatalog within ArcMap — this can be very helpful. We'll do this in the next part of the tutorial.

3. Creating a Map with ArcMap

You will now learn the basics of using GIS data to explore an area and create a map. Your efforts will be focused on
Somerville, Massachusetts.

Opening ArcMap and adding data layers

To start ArcMap, choose Start = All Programs > GIS Applications = ArcGIS 10.3.1 = ArcMap (note: on home
computers with the ArcGIS student license installed, the ArcGIS program may be under Programs -- ArcGIS 10.3.1). It will
take a minute to start.

1. When the first dialog box comes up, highlight the option to start with a new blank map and press OK.


http://www.mass.gov/anf/research-and-tech/it-serv-and-support/application-serv/office-of-geographic-information-massgis/datalayers/layerlist.html
http://www.mass.gov/anf/research-and-tech/it-serv-and-support/application-serv/office-of-geographic-information-massgis/datalayers/layerlist.html
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Q ArcMap - Getting Started

Open existing map or make new map using a template

=) Bxisting Maps My Templates
i i-Browse for more..
(=~ New Maps

(= Templates
[2J- Standard Page Sizes

i Architectural Pag
- 150 (A) Page Siz
- North American Blank Map

(=)- Traditional Layouts
i Industry
- USA
i World

-Browse for more...

P T »

C:\Users\nsusma0 1\AppData\Roaming \ESRI\Desktop 10. 2\ArcMap \Templates \Normal. mxt

Default geodatabase for this map: What is this?

C:\Users\nsusma0 1\Documents\ArcGIS\Default.gdb / - B
[~} Do not show this dialog in the future. [ oK ] l Cancel ‘

On the top of your screen, choose Customize = Toolbars, and make sure that Standard and Tools are visible.
They will have check marks next to them; if not, click once on each.

On the left side of the screen, you should see your Table of Contents area. Right now it should only say "Layers".
If you do not see this separate area, choose Window > Table of Contents.

4. Use the mouse to pass over the various tools that have been docked, and see what they do.

Q Untitled - ArcMap
File Edit View Bookmarks Insert Selection Geoprocessing Customize
& Standard
=2l toolbar
CROYEI JEER -TIN @
Table Of Contents xx
S Layers Tools
= toolbar
Table of
contents
&-
5. Click on the Plus sign to Add Data

6. Ifyou're in the Data Lab, you’ll see a list of default folder connections (M:, S: and H:). Navigate to where you

have stored the Tutorial Data Set (MassGIS and Somerville). In the Data Lab that will be your H: drive. If you're
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working outside the Data Lab, and you have already made a folder connection in ArcCatalog, it should be
available under Folder Connections in ArcMap:

T T —————

File Edit View Bookmarks Insert Selection Geoprocessing Customize Windows Help
DeE@& taax > @B - EFEE0
QA MO« IR0/ E NS LITIEE

Table Of Contents : -

EEELE
< layers | Add Data

] He
] M

ﬁ Toolboxes
[ Database Servers Then choose the

@ Database Connections appropriaie folder

[ 615 Servers connection
@ Tracking Connections
@ Coordinate Systems

Name:

Show of type: [Damsets and Layers

7. Navigate to the Somerville folder and add all the data layers you see below (hold down the CTRL key to select
multiple files at once — substitute 2009 Parcels if you have those):

i i -
Look in: ’ESome’vie v]ﬁ@ﬂ|§'|ﬂl|&laﬁ

EU|Id|ng shp
&) CityBlocks.shp
2 CityBoundary.shp
n:lghborhﬂnds shp
Parcels2004.shp
Parks.shp

Streetscl.shp

l‘1[| ‘1[| ‘1[| ‘1[| ‘1[| ‘11| 3

Mame:

Show of type: | patasets and Layers v]

If you missed adding one of the layers, click on the Add Data icon again and add them.

Using ArcCatalog within ArcMap to Add Data

It’s often useful for data management to have ArcCatalog open within ArcMap, and this also provides another way of
adding data.
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9.

10.
11.

12.

13.

Within ArcMap, choose Windows - Catalog from the main menu — this adds ArcCatalog to your ArcMap

session.
) Untitled - ArcMap - Arcnfo

File Edit View Bookmarks Insert Selection Geoprocessing Customize | Windows | Help
O2ds& B o e 129106 s Overview :
BE MG 2erT 1§ - i ] = RS :Iagmﬂer
Table Of Contents I x L=y
S$¢E|H Table Of Contents
B = layers |m Catalog
=] Streetscl Sl Search Ctrl+F
i Image Analysi

= Buildings

Click on the auto-hide pin icon in the top right corner of the Catalog box to pin it in place (otherwise it
disappears after every interaction).

| Catalog I x
e->o @ E-le
Location: @ Home - Documents\ArcGIS
= & Home - Docume
£ Addins
3 Packages
£ Web Maps
|3 Default.gdb
@ Toolbox.tbx
El FH Folder Connections

Note: In the Tufts Data Lab you should have at least three folder connections in addition to any folder
connections you have added manually.

Click here to
keep ArcCatalog
open

Expand the folder that has your GIS tutorial data set and navigate to MassGIS = Physical Resources.

Click and hold on the Hydro25k_poly_clip file and drag it into your ArcMap window — after it draws, take a look
at it — what does it seem to represent?

Drag Hydro25k_arc_clip into your ArcMap window — what does it represent? (hint: MassGIS has metadata here:
http://www.mass.gov/mgis/hd.htm) Your map is a bit of a mess with all these layers!

In the Table of Contents, turn off (uncheck) all of the data layers except for street centerlines (Streetscl),
hydro25k_poly_clip, and parks. They should remain listed in the Table of Contents, but should not be visible in
the map view.

Now you know two ways to add data to a map: by using the Add Data button, or by dragging them from ArcCatalog. It is
very handy to have ArcCatalog open in ArcMap while you work, so you should get used to making its window visible at
the beginning of every ArcMap session (remember to pin it in place!)

Getting around a map

[+
Zoom in to a part of Somerville using the Zoom In tool when using the zoom tool, you can click and drag a
box around the area you would like to zoom in to.

®la
Use the zoom in, zoom out, and pan tools = S“m to move around the map, and the Zoom to Full Extent

Q

tool to go back to the full view — after you have played with these, Zoom In to Somerville again.

i

If you can't get your bearings, try clicking on the Identify icon ( ) and then click on street centerlines or

parks.

11
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10.

11.

M

Can you find Professors Row on the Tufts University Campus? Click on the Find icon
Toolbar), click on the Features tab, and type in Professors Row, then click on Find.

AaOQ e -0 @ BILNADS

ble Of Contents 2 x / / / -
Ll < K

(docked on your Tools

7
| 88 Find =
Features ;Loca’u'ons'i Linear Referencing"‘ [ Find
Find: Professors Row v
In: | <Visible layers> L] [_r:lﬂv Search

V|Find features that are similar to or contain the search string

Search:
@ Al fields
In field:

‘ Cancel

A list of results will be produced. Click on one, and you’ll see a “flash” at its location on the map — you may have
to move the dialog box to see the location, or zoom out your map view. You can also right-click on a result and
get different options like Zoom to and Pan to.

Close the Find box.

Right-click on Streetscl and choose Label Features (be sure you right-click on the actual name and not on the line
symbol). Labels should appear on some streets.

Try zooming and panning again with the labels on.

Turn on the Buildings layer. If the buildings don’t appear, they may be under another layer —layers can block one
another, depending on how much area they cover. You can make them draw on top by clicking on the Building
layer and dragging it up above the other layers in the catalog. This is how you move layers around on a map.
Turn the Building layer off again for now.

When you are done looking around, right-click on the CityBoundary layer and choose Zoom to Layer — this fills
the screen with the Somerville City Boundary area. Note: the CityBoundary layer will not appear itself, however,
because it is turned off — you just zoomed to its extent. If you want to see it, left click once on the small box next
to its name in the Table of Contents.

Choose File = Save. In the lab, save to the H: drive under the ArcGlS Basics folder. Name the map file
basemapl.mxd. This action creates a map file (.mxd). A map file is a very small file that contains pointers to your
data sets and remembers what you had up in your session. If you quit ArcMap at this point, the next time you
start it, you can choose to start with this existing mapfile and it will automatically pop up all the data layers you
added in your first session and with the view of the data just as you left it. Thus, map files are easy ways to save
work. But beware - map files do not actually contain the data layers, they only have pointers to the data layers.
If you copied your basemapl.mxd file and tried to open it on a home computer without the GIS data layers it is
referencing (e.g. parks, hydro25k_poly, streetcl), an ArcMap session would start and list the data in the table of
contents but nothing would appear because it would not be able to find the data it is pointing to.

Save your mapfile frequently, and always save it at the end of a session!
12



Tufts University Data Lab

Defining the General and Symbology Properties for a Layer

In this section of the tutorial, you will learn how to organize your data layers' properties to start bringing some
coherence to the map.

If you haven't turned off the labels already, turn them off now by right-clicking on the Streetscl data layer and
unchecking Label Features. This will speed things up while you work.

Assigning proper layer names

First, you need to give the data layers better names than what they have (e.g., Streetcl should say "Streets")

1.

Right click on the Streetscl layer and choose Properties (alternatively, you can double-click on the data layer
name).

When you see the Properties dialog box, click on the General tab. In the Layer Name box, type in Streets instead
of streetscl. Press OK when finished.

Note: this does not change the name of the original data set - it only changes the name as it appears in this
session of ArcMap and as it will appear on your final map. If you went back to ArcCatalog, streetsc/ would still be
the name used.

Give all the other layers more coherent names as best as you can (e.g. “City Boundary” instead of CityBoundary,
“Ponds and Rivers” instead of hydro25k _poly_clip, “Streams” instead of hydro25k _arc_clip ). In the future, we
will deduct points on assignments for having non-standard English "data-speak"” names like "streetscl" appearing
in your map

Assigning proper colors

Your map would be a lot better if the water were colored blue, the parks green, etc.

1.

Right-click on the hydro25k_poly_clip layer (“Ponds and Rivers” or whatever you have called it now) to bring up
the Properties dialog box again.

Click on the Symbology tab

To change the color of the layer, click on the colored box under Symbol - this should bring up the Symbol
Selector box.

13
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4. Click on the small colored box next to Fill Color, to see colors to choose from — choose a blue color for water
e

‘Map
ookmarks Insert Selection Geoprocessing Customize Windows Help SymbiofSelectos
<
b - [ 124829 v EHREBE P Type here to search v @ @ 28 CurentSymbol
52 IS ~ | i ] hadlll, Mol - Search: @ Al Styles ") Referenced Styles

Layer Properties
o Gme«al}Soume[Se&eﬁlon]éspLay‘ Symbology ‘Hélﬂsd Definition Query [Labels | Joins & |
Show: ]

m

Fashuoe Draw all features using th¢ same symbol .

Single symbol Fill Color: |
Cat prk Symbol CJ
&mn:ma / Advanced -~ Outiine Width:  0.00
Muitiple Attributes outine Color: |l -
m Legend
Label appearing next to the symbol in table of contents:
4

J

Q Additional description appearing next to the symbol in your map's leq

Style References...

ar
Cancel

r Symbol - this should

o choose from — choose a

1]
5. Press OK when you are finished, and OK again to return to your map.

6. Color the parks layer green.

7. Turn on the buildings (left click once on the box to the left of its name in the Table of Contents) and color them a
light gray.

a. Note that the buildings still appear fairly black — that’s because the symbology settings have applied a
black outline around the gray fill. You (and your map's viewers) do not need to see these outlines. Turn
the outlines off by going back to the layer's properties and the Symbology tab. Once again click on the
colored box under Symbol. Then click on the small box just right of Outline Color, and choose No Color.
Press OK and OK again to get back to your map. This is how you turn outlines off (you can also change
their color or thickness).

14
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)
Symbol Selector <l
1
E Type here to search v @ @ 22 -  CurrentSymbol
.| Search: @ AllStyles (©) Referenced Styles Pa -
ESRI -
rr'
g . A
_a Green Blue Sun l
7 (]
Z
Hollow Lake Rose
Z
4 EditSymbe — — — — e
il Beige Yellow Olive E  BmEHULIOHE N RS
- OEEE(ONNEEEN
AEENm WI@.IIII;
] PEEENEEEEENN;
EEEEEEENEEEN
7 Green Jade Blue HEE 1 1 HEE
- EEEECNEEE NN 1
H BT |}
7 Style Referer e E EEE
4 EEEN EEEER
| o | [(MEEESESESESEENNN
] — I More Colors...

8. Turn on the neighborhoods layer and go to its symbology properties. Use the “Hollow” scheme (no fill color, with
an outline), and make the outline width thicker (e.g., 2) as shown below:

Symbol Selector | % £L
Type here to search - @ 8 %% »  Current Symbol
Search: @ All Styles () Referenced Styles
ESRI -
Green Blue Sun i

Fill Calar: E

Outline Widthe 2

Hollow Lake Rose Outline Color; E
o [Eatsymboi |

9. Turn on the labels for Neighborhoods (right-click on Neighborhoods layer and choose Label Features).

10. Drag the Neighborhoods layer to the top of the Table of Contents.

11. Using what you have learned, give appropriate colors to your other layers, with the exception of the Parcels
layer.

A tip for coloring roads: The road centerlines, at least for non-major roads, often look best in a map if they are colored a
light gray. That way they show up but won't dominate the map.
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12. When finished, choose File > Save again. Now your basemapl.mxd file will remember all the colors and names
you have assigned. It's starting to look better....

Drawing a layer based on an attribute value (land use codes)

Some of your layers would look better if you could distinguish between types of features in the same layer. The Parcels
layer, for example, shows property boundaries but doesn’t give us more information when drawn with a single color.
You can use an attribute field to symbolize your data to reflect the field values.

Suppose we want to color parcels by their major type of use (e.g., commercial, residential). The attribute table contains
relevant information in this regard, but unfortunately, we have no metadata to explain each attribute column.
Obviously, to know what attribute fields are appropriate for use in symbolizing your data, you must be familiar with the
attribute table structure, its fields, and the possible values of each significant field. Sometimes this can get confusing
because there may be many fields, and the values in those fields are codes with which you are not familiar. This is when
metadata becomes very important. Without metadata, you are stuck trying to track down this kind of important
information about the data set. Still we can figure out some attributes by looking at the Parcels attribute table.

1. Turn on the Parcels layer so it is visible.

2. Open up the attribute table for the Parcels layer by right-clicking on the Parcels layer name in the table of
contents and choosing Open Attribute Table.

3. Scroll across the table until you see the Use_descri (Use Description) field. If you are using the Parcels 2009
dataset, look for Use_Des. Note that there are a number of uses in the parcel data layer.

4. Look to the right of the Use_descri column and you will see a CLS column (in the 2009 dataset, it will be four
columns to the right). Look at the values in the CLS column and compare them with the Use_description column.
What do you think the CLS values represent?

5. Right-click on the CLS name at the top of the column and choose Sort Ascending as shown below:

Table 0O x
ERAE- AL 5
Somerville Parcels 2009 X
USE_DES CONDO_UNIT | GROSSSF | NETSF f CLS9.ACCT_NUM| OWNER -
CONDO MDL-05 2 2051 | 2051 (R . S - | (3
TWO FAMILY 4394 | 3264 |R |= Sort Ascending ix
TWO FAMILY 4578 2136 |R = St Raccaing
TWO FAMILY 4432 | 2660 |R &
0 0 Sort the values in this field in
TWO FAMILY 4704 | 2160 R % ascending order (A-Z) (1-9). )
TWO FAMILY 4728 | 2168 |R
TWO FAMILY 4652 | 2894 |R NA M
TWO FAMILY 3205 1850 |R Field Calculator...
TWO FAMILY 4403 201(; R Calculate Geometry... % BRIAN
THREE FAM MDL-01 4943 2942 R Turn Field Off
4DL-95 5 -
GAS ST SRV MDL-9 1584 | 1470 »c i Frocze/Unfreeze Colomm
< | 1 »
— X Delete Field
.
o« 0 » » [|[E|E | ©outof 14595 Selected)
. = " Properties...
Somerville Parcels 2009

6. Scroll through the values, comparing them to Use Description —is it any clearer what the R, C, |, and E
represent? Note: there will be several records of “Null” values to initially scroll through.

7. Close the attribute table.

8. Double-click on the Parcels layer to open up properties and click on the Symbology tab.
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9. On the left side of the Symbology dialog box, click on Categories, and then Unique Values.

10. From the pull-down menu under “Value Field,” select Use_descri (or Use_Des).

11. Next, click on Add All Values - each unique value in the Use_descri field of the attribute table will appear with its

own color. Your dialog box should look something like this
Layer Properties '

| General I Source I Selection | Digpla

B,

ields | Definition Queny I Labels | Joins & Relates | Time |

|

| Symbology |

SI::LT[_“ Draw categories using unique vdl.e[_z field.
Categories |\ Walue Field /k r Ramp
- Unique value USE DESCRI ~|| ™ v
Unique values, marmy N
‘. Match to symbalz in a
Quantities Symbol  Value Label Count
Charts :l:all ather values: <all other values: 0 |E|
Multiple Attributes <Heading> USE_DESCRI 14637
1256
TFAM MEX 1FAM MEX 26
121ACORF 121A CORFP 2
« [ ¥ 2 FAM MIX 2 FAM MIX 33
JFAM MIX JFAM MIX 7
AC LND IMP AC LND IMP 33
ACCLI\{_ | ACCLND MFG 1
APT ﬁ APT 4-8 601 -
Fy 2
Add All Values"] Im\n’alues... ] Remaove Remove Al ] [ Advanced -

12. Press OK to return to your map.

13. Zoom into an area so you can clearly see individual parcels. You may have to reorder the layers in the Table of
Contents to see the change.

This way of coloring by land use is interesting, but there are far more uses than there are colors, so you can’t really tell
which parcel has which use. This is NOT a good way to communicate land use! What might be a better way to visualize
land uses?

Fortunately, there is a more generalized land use attribute field in the Parcels data layer, as you saw earlier — the CLS

field. Looking at the attribute table, and knowing something about parcel assessment and planning, we will surmise that
the codes are as shown in the table below. The planning profession also has some generally acceptable color standards

for visualizing land use that we provide here (see the APA’s Land Base Classification System Level 1 Color Standards for
the official recommendations from the American Planning Association):

Code and Use Standard Land Use Color
R — Residential yellow

C — Commercial red

| — Industrial purple

E — Exempt (meaning the landowners do not pay property taxes, indicating blue

government, educational, religious, or other tax-exempt civic use)
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1. Double-click on the Parcels layer to get its symbology properties = choose Categories = Unique Values again,

and set the Value Field to CLS.
2. Click on Add All Values.

3. Fillin the dialog box as you see below, changing color and text — note: You can change the name of a category by
clicking on it in the label column. Set the colors for each category according to the box above. You can do so by

individually double-clicking on the colored boxes. Your categories may appear in a different order then shown

below.
Layer Properties

|

‘ General I Source I Selection I Display| Symbology | Fields I Definition Guery I Labels I Joins & Relatesl Time I HTMLF

Show:
Features

Unigue values CLS -
- Unique values, marty

Draw ies using unigue values of one field.

Categories Value Field Color Ramp

-

4 11 | Industrial

Unkown

. Match to symbals in 3|
Quantities Symbol  Value Label Count
Charls |:| <all other values> <all other values:
Multiple Attributes <Heading> lardlsel ]
R Residertial ?
. Commercial Click on each row to
s Exempt

change thelabel to
its full description.
Also, for Heading,
instead of CLS,
make it say Land

[ Add All Values ] [ Add Values. . ] [ Bemaove

] [—A\Use

Note that there was a blank row. That’s because when we chose “add all values” for the CLS field, the software

found a lot of blank values. We don’t know what they are, so we call them Unknown.

4. You can move the classes around (e.g., to make Residential come first, etc.) by highlighting the class (e.g., R) and
using the arrow keys to the right to move it up or down.

5. Asyou can see, it takes a lot of time to set up the data layers to be colored and labeled appropriately. Save your
mabp file again at this point (File = Save) and if you quit now, you would be able to get back to your map session
again very quickly, including all your colors and labels.

Loading a layer file

Important Note: The following steps may result in ArcGIS crashing and the program closing, so save your map file before
continuing (File = Save). If the program closes, use My Computer to navigate to your saved map file (basemap.mxd) and

double-click on it. This will start ArcMap again and it will open to where you were. After that, you can repeat the
following steps, and it should work fine. This is a good lesson that you should save your map file frequently!

Layer files are special files that contain formatting (color, labels, etc.) for a particular data set. There are two good
examples of layer files created by the folks at MassGIS for major roads and railroads. To load these layer files:

1. Click on the add data icon and navigate to the MassGIS / Infrastructure folder

18



Tufts University Data Lab

2. Add the two files that end in .lyr as show below:

wibe 1 R :
Look in: lEIInFrastructhe '] & L-a'| = v| E| BEO %

" EOT_MajorRoads_Class.lyr
=] EOTMAJROADS clip.shp

d :-*Railroads_by_Service_Type.Iyr 4
=] TRAINS_ARC.shp Add the two layer
(.lyr) files

Mame: EQT_MajorRoads_Class.lyr; Railroads_by_Service_Type.ly

Show of type: ’Daiﬁsetﬂ and Layers v] [ Cancel l

You'll see a red exclamation mark (!) by Major Roads in the Table of Contents:

BEEELYE
5 £ layers

=] Major Roads I

Road Classification

13

= Limited Access Highway
== Multi-lane Hwy, not limited a
— Other Mumbered Highway

— Major Road, Collector

This means that the layer file cannot find the actual data source (for the major roads, this is the
EOTMAJROADS_clip shape file).

Try turning on the Major Roads layer by check-marking it. Turn it off and then turn it on again, which brings up a
Set Data Source dialog box — in that dialog box, click on EOTMAJROADS_clip.shp in the MassGIS\Infrastructure
folder.

a. If adialog box does not appear, right-click on the layer name (Major Roads) and choose Data — Repair
Data Source.

In the navigation box, look for the MassGIS/Infrastructure folder containing the EOTMAJROADS_clip.shp file -
click on the shape file and ADD it. Make sure to checkmark it in the Table of Contents to turn it on.

Vs v

W TN
Set Data Source | = 1 =
- =

Look in: l{ﬁlnﬁ'asb’uc\we / '] 2 B 3| = " El‘ Bl & ud
=

= EOTMAJROADS clip.shp *
|- TRAINS_ARC.shp

ST

Name: EOTMAJROADS_dlip.shp

Show of type:  (Feature dasses v} i Cancel }

T
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The Railroads layer may or may not appear — use the same steps as above if necessary.

You'll see that these layer files include colors, line styles, and labels, including highway shields for the interstate and
state routes, and different railroad symbols depending on the current status of the track. These were set by the staff at
MassGlIS and saved as layer files to accompany the GIS data sets. You can have many layer files for one GIS file,
displaying the same GIS data in different ways (for example, you could display parcels to show land use or to show land
value).

6. Save your basemapl.mxd mapfile again.

Labeling a layer based on an attribute field

When you checked the "Label Features" button for streets and neighborhoods, you were using a function that allows
you to label features based on an attribute field for the layer. When you use that function, it labels all the features in
the map. You can also label features one at a time by pointing to them. First, however, you need to set up the Label
properties to choose which field you will use to label, font, color, etc.

Before continuing, turn off the MassGIS major roads and railroads, as well as the Parcels layers — this will speed things
up a bit as you continue to work on your map.

Save your map.

Changing the formatting of labels

Earlier, you turned on the labels for the Neighborhoods layer. Let’s say you want to have the Neighborhood names stand
out more on the map. We can do this by changing the label’s format.

1. If the Neighborhoods labels are not turned on, turn them on now (right-click on the Neighborhoods layer and
check Label Features)

Right click on the Neighborhoods layer name and choose Properties.
Click on the Labels tab.
Make sure that the Label field says HOOD NAME.

v ok wN

You can choose the font, size and color of your labels by clicking on the Symbol... button — try the Neighborhood
name bold with 12pt font.

o

When you are done, return to your map.
7. If you don’t like the results, adjust the label format again as you wish. Check out some of the predefined label
styles.
Interactively labeling particular parks

1. The labels we have been adding are based on attribute table value. Open the Parks attribute table (right-click
on the layer name and choose Open Attribute Table).

2. Look through the table. You will see that a field called Park_Name contains the park name. We want to use this
field for labels.

3. Close the table, and open the layer properties of Parks.
4. Click on the Labels tab.
5. Make sure that the Label field says Park_Name.
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10.
11.

12.

13.

14.

15.
16.

17.

18.
19.

Using the same steps as before, make the park name italic.
When you are done, return to your map.

No labels appear yet. Try labeling all the park features at once by right-clicking on the layer name and choosing
Label Features. This turns the labels on. There are a lot of labels and this makes for a rather messy map. We
want to label only the largest parks.

Turn off the Label Features function.
Click on the Parks layer in the Table of Contents and drag it up so that it is at the TOP above the other layers.

To label features interactively (one by one) you need the Draw toolbar. Choose Customize -Toolbars, and click
on the Draw.

In the Draw toolbar, click on the arrow nest to the "A" icon and then the Label icon as shown below:
Q basermapl.mud - ArcMap - ArcInfo

File Edit Wiew Bookmarks Insert Selection Geoprocessing Customize Windows Help

O s B o o |- 129106 - EEEE T e ?
BRIl e |- 0N B2 MR OR,
Table Of Contents 4 I
= & K | 5=
a8 H Drawing*lE' O-A - 6] Al ~
= = layers WA NewTed —_—
[ Major Roads 8% colined Tod
O Railroads =% Spline
=] neighborhoods |U:| Label |
0 LI Callout
= [ Buildings w Polygon Text
Al Rectangle Text
= OO Streams
— A Circle Text e
=] Streets
Tufts
= Rivers and Ponds
= v

A pop-up box appears on screen —you can ignore this for now but note that it is set to use the label properties
you just defined.

Click on a larger park. The label will appear. (Note: if you accidentally click on another feature like a street, its
label will appear instead — zoom into the map if you need to get a better view of a park). If needed, click the Edit
toolbar at the top of the screen, and then Undo.

Label some other large parks.

Close the interactive labeling box when you’re finished.

You can move or delete a label by selecting it with the “select elements” icon K on the Tools menu. To move
it, click on the label with the pointer icon (this selects the label) and move it to where you want it. To delete it,
select the label and press the delete button.

Close the Draw toolbar for now or just drag it out of the way.

Save your mapfile when you’re finished.
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Measuring features and drawing a map to scale

Making measurements and scaled maps is a very important GIS function.

Measuring distances and areas

@ BELE|M S S Bl

2. Click somewhere on the map to start a measuring line. Drag the line somewhere else and click again. You will
see two measurements reported in the Measurement window. The first, segment, gives the distance (in meters)
of the line you just drew. The second, Length, gives the total distance. Click on a third point in the map. You will
see the new segment distance plus the total distance of both segments. Double-click on the map to stop
measuring (or choose a different tool).

1. Click on the Measure tool in the Tools toolbar.

3. If you want to measure in a different unit, click on the little black triangle as shown below and select a new
distance unit:

" -

Kilometers
Meters
Decimeters
Centimeters
Milimeters

Miles X
Nautical Miles
Yards

v Feet
Inches

4. Try calculating the area in acres of the Somerville section of the Tufts campus (turn on the buildings to help
guide you) — use the polygon tool in the Measure tool as shown below and set the area units to acres:

IR WA= T, WX Mol
1x Measure‘ @

E (= IESIER:
||| Line measurem Distance 3 i I /\
Segment: 393, 1
Length: 2,730, Area ] Kilometers
! - Hectares
Meters
Il Ares
. Miles
v | Acres
: Feet J

Hint: If you want to measure a new area or length, close the measure tool and open it again.
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Drawing a map at a set scale

Many professional map users expect printed maps to be at a standardized scale. USGS topographic maps are printed at
1:100,000 scale (1 inch on the map equals 100,000 inches in the real world or about 1.58 miles) and at 1:24,000 scale for
example (1 inch on the map equals 24,000 inches in the real world, or 2000 feet or about 0.38 miles). In ArcGIS you can

scale your map to any scale, but you are also offered standard scales from which to choose.

1. Set the scale of your map to 1:24,000:

Insert Selection Geoprocessing  Customize  Window

)

hEd -

o x

2. Experiment with some of the other map scales. Which scale would be good for a detailed map of East
Somerville or the Tufts campus? What about for a study of transportation in metropolitan Boston?

3. Try typingin 12000 in the scale box — this creates a map at 1:12,000 scale (1 inch on the map equals 12,000

& - || Bl =]
- .

1:1,000
k 1:10,000

1:100,000
1:250,000
1:500,000
1:750,000

1:1,000,000

inches in the real world, or 1000 feet).

It’s important to start becoming familiar with map scales. You have been using what is called a unitless scale —e.g.,

1:24,000 means 1 of any unit on the map (inches, centimeters, feet) equals 24,000 of those same units in the real world.

Using Data from ArcGIS Online

Note: the following task will sometimes not work, most likely due to server issues. If it fails, try it again. Also be sure

to save your mapfile before starting the next step because ArcMap may crash.

Increasingly, ESRI and city and state agencies are setting up online GIS data servers that you can access from ArcGIS.
We're going to use some of these services now, adding imagery and a basemap.

1. Click on File > Add Data > Add Basemap:

L3 basemapl.mxd - f‘rcﬂp - Arclnf

Edit VWiew Bookmarks Insert Selection Geoprocessing Customize  Win
B New Ctr+N  # - | 128,106 A=l
0] Ctrl+0
B Open "0 I x @ L R
& Save Ctrl+5
Save As
Save A Copy...
| Add Data v | &+ Add Data.. =
EH Sign In... B9  Add Basemap...
BH ArcGIS Online... HH Add Data From ArcGIS Online... !
i
Page and Print Setup... £+ Add XY Data...
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2. Click on Imagery and then Add:
— K y 4

P . ™
! BE Add Basemap [==]
|
r| =
) DT
Imagery Imagery with Labels Streets Topographic
T
)‘ -
3: - NORTH
1l ATLANTIE
1} A prrARES -
" e
Terrain with Labels Light Gray Canvas National Geographic Oceans e
\\ g
Y i e Al
CpenStreetMap
Y ————
Cancel ’
ke 0 < 7 -~

It will take a few moments to load the imagery.

3. You'll get a warning about the geographic coordinate system — click Close on that warning for now. Click Yes if
you get a warning about the Hardware Accelerator.

4. Be patient — the imagery will take a while to draw!

5. Once you see the imagery, try zooming into a small area, like the Tufts campus or a few buildings. You’ll see that
it takes a minute but that the imagery will sharpen.

6. Turn off the imagery for now (it will be listed in the Table of Contents as Basemap).
7. Click on File > Add Data = Add Basemap again, and this time choose Topographic.
8. Once the Topographic map appears, try comparing it with some of your other map layers. What are the
advantages of using this Topographic map service? Do you see any disadvantages?
Making data layers transparent

Suppose you wanted to show land use by category over aerial imagery. You can display layers above the aerial imagery
or shaded relief to be somewhat transparent if you like.

1. Turn off the Topographic map service.
2. Turnonthe Imagery again.

3. Turn on the parcels (they should still be colored by general land use).
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or,

fig
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s
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Zoom into Davis Square or Tufts University or Union Square.

Right-click on the parcels layer and open its properties.

Go to the Display tab. Set the Transparent entry to 70% and press OK to see what happens (it may take a while

to draw).
TS

Layer Properties

=]

| General | Source | Selection | Display Tgymbology | Fields | Definition Query | Labels | Joins & Relates | Time | HTML Popup |

Scale symbols when a reference W

Transparent: 70 %

Display Expression

Field: ST_NAME

["] sShow MapTips using the display expression

Hyperlinks
["] support Hyperlinks using field:

none

@ Document URL Script

Feature Exdusion
The following features are excuded from drawing:

Expression...

Feature ID ST_NAME

Restore Drawing

Restore All

mrT -

7. When you’re done experimenting, save your mapfile again.

Creating a map for printing or exporting as a digital graphic

Now you’re ready to create a well-designed map. But please read the following first....

When you create a map, you should include the map itself, plus a title, a legend, a scale, and a north arrow. You should

also provide the name of the cartographer (you), a date, and acknowledgements about data sources. Here is an

example of a complete map:
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e ROV = -

Union Square, Somerville Land Use P 2

0 250 500 Feet /l Residential Industrial

| ) <R X
N Commercial Unkown - n; o

Cartography by Barbara Parmenter, July 19, 2011 T | ' ™

Data source: City of Somerville and MassGIS. Exempt ra Lo

Land use information is circa 2004

It is important in a map not to include too much information. You would not want a map that includes all the data layers
you have in your ArcMap session from this tutorial. It would be much better to do several maps, e.g., one showing the
general layout of Somerville with streets and parks, another showing land use, possibly one showing the buildings in
black with all the other space blank (this is called a Nolli map by urban designers and is used to explore a community’s
built fabric).

You may also include other elements on your map, for example, more explanatory text, charts, tables, photos, or other
images.

Note that you can also have more than one more than one data frame on a layout — for example, you can have a small
locational reference map (as in the map above) or an inset map to show an area in more detail. See the next section
(Adding a data frame to show two or more maps on a layout) for instructions about how to do this.

To do all this, you will move into Layout View. Layout View is much like viewing the page layout when you are working in
a word processing software. You should do all the preliminary work and analysis in the data frame view (where you
have been up to now in this tutorial), then move into Layout View only when you are ready to create a map.

For detailed information about layouts, see Help — ArcGIS Desktop Help — Professional Library — Mapping and
Visualization — Page Layouts.

If you don’t already have it open, start ArcMap and bring up your map file from the earlier part of this tutorial.

Setting up a map layout

1. Before you start a map layout, it is important to think through what you want to do and how you want your map
to look. What do you want to show? How large do you want your final map to be? Portrait or landscape
orientation? Do you need space for additional text or graphics? This tutorial example will assume a paper size
(8x11 inch) map but often you are making map for publications where they must be smaller, or for Powerpoint
where they need to be a certain size (e.g., 7.5x10 inches), or for posters where they may be much larger than
8x11.

2. In ArcMap, choose View = Layout View from the main menu.

26



Tufts University Data Lab

3. The view changes to show your data frame on a page layout and a new toolbar appears — the Layout toolbar.

4. The first thing you should do is to set up your Page properties. Choose File = Page and Print Setup.

5. Inthe Page Setup dialog box, make sure that the page size is set to Letter. Also check either Portrait or
Landscape (which would be better for the map you want to create? The example map is in Landscape

orientation). Press OK to return to the map.

Moving around in the page and data frame

It is very important to understand the difference between the Layout toolbar and the regular (data frame) Tools toolbar.

They share similar tools (zoom in and out, pan) but the layout tools work on the layout as if you were zooming in and

out of the paper itself, while the same tools on the Tools toolbar work on the data inside the data frame (e.g., zoom into

Davis Square). You will get confused occasionally, but once you get the hang of the two toolbars, you will be off and

running. For now experiment with both to see what happens.

The Tools Toolbar The Layout Toolbar

QM@+ |[E
EELEELE I

Use these to navigate within the

data frame on your map (e.g., The 1:1 tool is particularly useful to see
you want the data frame to be what the map features and text looks like at

slightly more zoomed into Davis |actual print size.
Square, or you need to pan the

-
data frame to the north). The Zoom to Whole Page tool = will take
you back to the entire page view.

Resizing and moving the data frame

You will always need to re-size things in your map, especially the data frame itself which contains the map image. On the

left below is something you might see when you first start a layout. In this case we are moving and resizing our data
frame so that it fills the upper 4/5ths of our page. We'll then put a title, legend, and other map requirements in the

blank space along the bottom of the page:

Data frame and layout page not adjusted

Data frame after resizing and moving to fit the

layout page
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Moving and re-sizing in ArcMap works similarly to most other programs where you use graphics. The key is selecting the

element first.

To resize and move the data frame, use the Select Elements pointer
Use the small grab points on the corners and sides to resize.

1
2
3. Place the cursor anywhere over the data frame to move it.
4

K

to select the frame first.

Alternative: With the frame selected, right click and select Properties—> Size and Position. You can adjust the size
of the frame here. If you switch the sizes in the width and height boxes, the data frame will appear in landscape

format.

Data Frame Properties

[=ll

General ] Data Frame ] Coordinate System I llumination | _Grids Feature Cache

Annotation Groups I Extent Indicators | Frame | Size and Postion

Position
X: 0.75in
¥: 0.75in
[7] As Offset Distance
Anchor Point:
(@] e—@
(@] (@] O
e—0—0

Product Library

Size

Width: 9.5in

Height: 7in

[T As Percen

["|Preserve As Defaultis 7 \
inches for

Element Name hei ghL 95

Layers inches for width.

Change the

sizes around. )

Inserting a title, north arrow, and legend

These are all usually required elements on a map. You access them by going to the Insert item on the main menu bar.
You can read more about these by going to Help - ArcGIS Desktop Help — Professional Library — Mapping and

Visualization — Page Layouts, but here are a few tips:

Use the Insert menu function to insert the required map elements:

Q bssemap2m - Arcap - ArcnG

File Edit WView Bookmarks

DpEas % 5@

R MOl M.

Table Of Contents /

= = layers V4
= [ Parks
|
[ Major Roads
= O Railroads
—+ Active Rail Service

Insert | Selection

-
=
=

= |

B = i

e
=]

Data Frame

Title

Text

Dynamic Text  »
Meatline..,
Legend...

Morth Arrow...
Scale Bar...

Scale Text...

Geoproc

|
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Insert Scale Bar

The scale bar you select will be in the Display units of your data frame (e.g., feet). If you want a different unit, double-
click on the scale bar. In the Scale Line Properties dialog box, select a different Division Unit.

Insert Legend

There are lots of ways to improve your legend. For starters, let’s say we're creating a land use map. We want the legend

and map to focus on land use. We have imagery in the background as in the example map, but everyone knows what
that is, it doesn’t have to be identified in the legend. To control what goes on the legend:

1. Choose Insert = Legend from the main menu.

2. djust what is in the legend so that only Land Use (

Parcels) is there:

Choose which layers you want to include in your legend

- 1. Select
everything
here except

-ny Land Use

2. Click here to PR e ey eel]
take all the layers Place Names (State Level)

except Land Use Place Names (County Level)
out of the Legend

et the number of columns in your legend: =

l 3. Experiment with |
number of columns

<Back | Ned> | [ Cancel |

3. Click the “Next” button, noticing the different settings options, until you get the option to click Finish.

4. You can modify an existing legend by double-clicking on it to bring up the legend properties. For example in the

Legend Properties, you can tell it NOT to show the word “Legend” or you can change that word to something
else. Notice these settings were available when you inserted the legend, but you can access them again here.
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5. Stillin the Legend Wizard box, click on the Items tab, highlight Somerville Parcels 2009, and then click on Style:

—LI S ——— P — —
~ ™~

1 Legend Properties

2]

l ]Items ILiI)'OtRIFtamelSizeandPositionl
he———
) Apply settings to selected item(s)

| selectal || selectnone |

Font
[Apply to al labels -

v v B
Map Extent Options

[] Only show dasses that are visible in the current map extent

[] Show feature count

(| Count |) | [V]show thousands separator

[ ]Use current index feature as the map extent (data driven pages)

Item Columns

[T Place item(s) in a new column

[ Style

] Column count for item(s) 1

[ L

6. Try out different styles and preview how they will look:

Ty ou
s tonsoeve ST i

B

Horizortal Single Symbol
Label Only

Legend
Layer Name

| EEE

Horizortal Single Symbol
Layer Name and Label

Legend

Heading

- Label Description

Horizortal with Heading,

4 Preview
teaer Legend = o]
";"9 g Lana use
Feesigents |
& - Description ::'"":CB'
Horizontal Bar with Heading,  Horizontal Single Symbaol sy
Labels, and Description Description Oy = Unkown
Legend Legend
Layer Name

- Description
Horizontal Single Symbol
Layer Name and Description

Click on
different styles

and preview
PES———— how they will
look above

Legend
Layer Hame
e
. o

Horizontal with Layer Name, = Cancel

7. Press OK, and OK again. If the map goes back to one column and you want two, double-click on the Legend again

and under the /

tems tab, type in 2 for columns
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Selecting Elements

Remember, you always have to select an element before you can move, resize, or change its properties. Use the select

K

You can select more than one element by holding down the CTRL key as you click on each element.

pointer icon on the Tools Toolbars.

Modifying an element after insertion

You can usually modify an element after you have inserted it by selecting it and then double-clicking on it. The relevant
dialog box will appear for that element (e.g., title, legend, scale bar).

Inserting text

To put in your name as the cartographer, and any other information, use the Insert -Text function. Remember also to
include a date. You should also have a data source note that the data comes from the City of Somerville and MassGlIS.

Add more text for any more descriptions or explanation.

You can change font properties on selected text by right-clicking on the selected text and choosing Properties.

Inserting a Picture

Note that you can also insert images into the data frame.

Deleting and trying again

If modifying an existing element doesn't work, remember that you can always select an item and delete it if you don't
like it. Select it using the select pointer, and press delete. Especially useful if your legend gets messed up - just delete and
insert a new legend again to start fresh.

Extent

If you accidentally move the extent of your map, you can use the pan (the hand) tool or the back button to return to
your desired location.

Saving map files under different names

Once you have created one map in a layout you like, you can save your map file (File — Save As) to be the name of that
map (e.g., Somerville Land Use). You can then use the same layout but change some of the visible features and save as a
new map name (e.g., Somerville Streets, or Somerville Parks).

This allows you to make maps fast once you have a good layout, and it allows you to make maps of the same area at the
same scale, but showing different layers of information.

Choose File =»Save As now and save the map file to an appropriate new name.

Adding a second data frame to show an inset map

You can add a second (or more) data frames to your ArcMap session. Only one data frame will appear at a time in the
data frame view (right-click on the data frame name and choose Activate to see the data frame you want). But in the

layout, all the data frames will appear. This can be handy for putting in a small "locator” map as in the Land Use Map

example:
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Adding a second data frame for a locator map

Multiple data frames can get a little tricky, and will take some practice. Play with them some, and remember to save

map files frequently under different names in case you mess up and want to return to a previous view. In this example,

we’ll use a new data frame to insert a locator map.

1. In Layout View, choose Insert = Data Frame from the main menu — a new data frame box appears in your
layout. You’ll see the New Data Frame listed in the table of contents:

Insert | Selection Geoprocessj Customize
Lé? Data Frame ir ' v |7

=
Ttle  Titl

T

Insert Data Frame

>

Create a new, empty data frame in
Dyn| the map. A data frame represents
] a geographic location and
Nea 2
contains layers of data.

O
[~ T=

®
z9 |

North Arrow...

-
-
3

Scale Bar...
Scale Text...

5 8

Picture...
Object...

iz LCBCIW ﬁ

=] Parcels2004
Land Use
Residential

I Commercial

Exempt
Industrial
Unkown

[1 Basemap

Basemap

o®

[ Boundaries a

O Transportatj
Imagery

=# New Data Frame
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2. Move and resize the new data frame box so it is in the location you want it — here we are taking it to the bottom
right corner of our layout:
Move and resize your new
data frame where you want
your locator map
. N N vk
[E] -0
Land Use Exempt |
Residential Industrial !
Commercial Unkown NeW Data Framé.
| |
3. You can add data to this data frame just as you did to the first one, or in the Table of Contents, you can drag a
layer from the first frame to the second. Try dragging the Somerville City Boundary layer from the original data
frame (called Layers) down to the New Data Frame and turn it on
2 =' New Data Frame
= City Boundary
1
¢) -
4. Use the Add Data icon to add the data set TOWN_POLYM from the tutorial data set under
MassGIS\Political_Boundaries — these are town boundaries for all of Massachusetts.
5. Make sure to drag the town boundaries below the Somerville City Boundary.
6. Make the TOWNS_POLYM fill color white with a gray outline.
7. Inthe table of contents, right-click on New Data Frame and choose Properties
8. Click on the Frame tab and change the Background color to blue — this will make the water appear blue.

| -

Data;;rrra Properti
General I Data Frame I Coordinate System
Feature Cache I Annotation Groups | Exent Indicators Frame ize @
Border
I 8 o @D
Gap X 0= pts : 0= pts ding: 0= %
Background

|E|-I Color:

Gap X 0= pts 0= pts Rounding: 0= %

9. Press OK to see the results.

10. Save your map file!

33



Tufts University Data Lab

Setting up locator map boundary box

Finally, we’re going to show a boundary box on our Locator Map.

1.
2.

3.

Right-click on the new data frame to get its Properties dialog box back.

Click on Extent Indicators tab and follow the instructions below, then press OK:

General | Data Frame | i llumination | Grids
Feature Cache |AnnutationGr0up5 Extent Indicators Ifmme ISizeand Position

L
You can add one or more extent indicators to this data frame. Each indicator
shows the extent of the data in one of the other data frames and automatically
updates if the extent changes.

Show extent indicator for

Other data frames: these data frames:
]

Highlight Layers (your original data

frame) and click on = , then press OK.

This will show the extent of the Layers'
data frame in your new data frame
Optdnes

If all this was successful, save your mapfile! Otherwise delete and try again.

Printing or exporting your map

To print, you must export to a digital graphic format like .pdf. Printing works just like any other Windows program, so we
won’t cover that here, but feel free to print your map.

The ability to export to a digital format is very useful. If exporting to an image, remember to set your page size to the
appropriate dimensions - this may mean custom dimensions, e.g., a small image to fit on a computer screen, a
powerpoint presentation, a web site, or word document. When creating a layout for digital export, you should think

ahead about what size you want your final image and lay out the map accordingly, and be sure to use font sizes that are
readable at the final map size.

1.
2.

When you have your layout the way you want it, choose File 2 Export Map.
In the Export dialog box that appears, navigate to your tutorial folder and give the image a name.

For Save as Type: choose a format - we recommend .gif or .pdf format because they come out well and are
readable across a variety of platforms. The only problem with PDF formats is that they do not recognize all text
fonts, so stay simple with your font types - e.g., Arial or Times New Roman.

Before you export, adjust resolution under the Options area. Digital images meant to be seen on a computer

screen do not need high resolution. 96 or 150 should be fine depending on image size, 300 should be the
maximum.

Press Export when you are ready to go - the process will take a minute.

Check your results by navigating to the folder outside of ArcGIS and opening the graphic - if not pleased,
experiment with different resolutions and compare file sizes.

That's the basics. Now practice what you have learned by creating several maps showing different aspects of the
Somerville area.
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